Teamcenter 11.5 lifecycle visualization

Release Notes
Contents

Release Notes introduction ................................................................. 1-1
Lifecycle Visualization products .......................................................... 2-1
Deprecated platform announcement .................................................... 3-1
What's new ....................................................................................... 4-1
  What's new overview ........................................................................ 4-1
  New features for Standard .................................................................. 4-1
    Sort parts in part reports .................................................................. 4-1
    Set measurement display units to match model units ....................... 4-1
  New features for Professional ............................................................ 4-1
    Immersive mode enhancements ....................................................... 4-1
    Assembly-level coloring in visual reports ........................................ 4-2
  New features for Mockup .................................................................... 4-2
    Sort and reorder part groups .......................................................... 4-2
    Clearance analysis enhancements .................................................. 4-2
  New features for Variation Analysis .................................................. 4-2
    Point Measurement Generator ....................................................... 4-2
    Enhancement to importing a process document from a text file .......... 4-3
    Point measurement enhancement .................................................... 4-4
    Virtual clearance measurement enhancement .................................... 4-5
    Custom measurement operation enhancement .................................... 4-5
    Position characteristic for plane features ........................................ 4-6
    Move custom assembly operation enhancement .................................. 4-6
    Link features and tolerances to DPV Lite measured data ................... 4-7
    Creating surface mesh for minimum feature clearance and variation visualization ........................................................................... 4-8

Supported platforms and locales ......................................................... 5-1
  Supported platforms .......................................................................... 5-1
  Supported locales .............................................................................. 5-1

System requirements ............................................................................ 6-1
  General system requirements ............................................................. 6-1
  License server requirements .............................................................. 6-1
  Teamcenter community collaboration visual conferencing requirements .......................... 6-1
  Graphics hardware requirements ....................................................... 6-2
  Help requirements ............................................................................ 6-3
  PDF requirements ............................................................................. 6-4
  IDW requirements ............................................................................. 6-5
  ADAMS conversion requirements ...................................................... 6-5
  Visualization Illustration requirements ............................................... 6-5
Contents

Convert and Print requirements .................................................. 6-6
ClearanceDB requirements .......................................................... 6-6
Interoperability with other software .............................................. 6-6
Teamcenter client communication system (TCCS) requirements .......... 6-6

Resolved Problem Reports ....................................................... 7-1

Enhancement Requests ............................................................. 8-1

Issues and workarounds ........................................................... 9-1

Supported file formats ............................................................. 10-1

Global Technical Access Center (GTAC) ....................................... 11-1
Chapter 1: Release Notes introduction

These Release Notes summarize the changes made for Teamcenter 11.5 lifecycle visualization, encompassing all of the stand-alone Lifecycle Visualization products.
Chapter 2: Lifecycle Visualization products

Teamcenter lifecycle visualization is available in multiple product configurations, some of which also support optional software modules.

Note
For the latest information on optional modules, licensing requirements, and pricing, see your Siemens PLM sales representative.
For more information about system hardware and software requirements, see the hardware and software certifications page on GTAC.

Base
Base is the entry-level viewer product configuration in the Lifecycle Visualization family of products. Providing powerful 2D viewing and markup capabilities along with basic 3D viewing functionality, Base is an ideal solution for the visualization of the many 2D and 3D file formats supported.

Features provided by Base include:

- Access to more than 40 2D file types
- A rich set of 2D navigation tools (pan, zoom, page changing, etc.)
- 2D adjust
- 2D markups and 2D GD&T markups
- 2D measurements
- 2D comparisons
- 2D printing
- 2D image capture
- 2D Snapshots
- Option to save and load session files containing 2D and 3D content
- Option to open and save .plmxml files
- .jt file support
- Direct read of Solid Edge and NX formats
• Visualize 4GD worksets
• 3D viewing
• 3D navigation tools (pan, zoom, rotate, fit all, zoom area, and seek)
• Standard views (view only)
• Basic support for product structure
• Basic 3D properties viewing
• Product and Manufacturing Information (PMI) viewing
• Basic 3D cross section functionality
• Basic 3D markup and 3D GD&T markup functionality (view only)
• Basic 3D measurement functionality (single and double only)
• Quick Pick, Smart Pick, and selection preview when selecting part features
• Basic 3D printing
• 3D Snapshots
• Ability to export images to popular formats (.jpg, .png, .bmp, .tiff, .hpgl, and more)
• Peer-to-Peer conferencing
• PDM integration

Base supports the following optional features:
• ECAD Viewer (PCB and Schematic file viewing, markup, measurement, DFx, and printing)

**Standard**

Standard provides an integrated environment for viewing data from multiple sources, including CAD, ERP, PDM, and legacy systems. An easy-to-learn user interface encourages collaboration among users without requiring complex training.

Features provided by Standard include:
• All the functionality provided by Base
• Direct read of 3D VRML and STL formats
• Advanced 3D viewing
• Enhanced navigation features
• Ability to view and interact with product structure
• Selecting parts by area or volume
• Ability to control visibility by layers defined in the CAD environment
• Advanced 3D measurements
• 3D markups and 3D GD&T markups
• 3D image capture
• Enhanced .plmxml file support
• Vis Issues Manager

Standard supports the following optional features:
• ECAD Viewer

Standard supports the following optional file converters:
• IGES
• STEP
• DXF

**Professional**

Professional provides access to several add-on modules that further extend the analysis capability of Lifecycle Visualization while also enabling users to author content.

Features provided by Professional include:
• All the functionality provided by Standard
• Advanced navigation features
• Ability to create and save alternate hierarchies
• 3D transformation, manipulators, and part manipulation mode
• Honor constraints in session files or PLM XML
• Advanced cross section functionality
• Comparing similar 3D models
• User-defined 3D coordinate systems
• Quick Color tool
• True Shading
• Advanced appearance tools
• Outline capture
• Creating and managing callouts and symbols
• Creating and editing thrustlines
• Generating exploded views
• Creating and playing motion (.vfm) files
• Capturing movies
• CAE results viewing
• Viewing Visualization Illustration documents
• Report generation
• Stereo viewing
• Virtual Reality device support
• Ability to export JT, Nastran, Robface, and VRML files
• Ability to export .plxml files

Professional supports the following optional modules:
• Visualization Illustration
• Concept Desktop
• Concept Showroom
• Variation Analysis
• Quality Producer (Windows only)
• ECAD Viewer
• Visual Reports
• Animation authoring
• .vfz collaboration file authoring
• ADAMS conversion (Windows only)
• STEP file export
• MetaVPDM

Professional supports the following optional file converters:
• IGES
• STEP
• DXF

Mockup

A real-time digital prototyping solution, Mockup combines a wide range of features with a robust set of dynamic analysis tools to help engineers identify defects in digital products at a much earlier stage of the product design cycle.

Features provided by Mockup include:
• All the functionality provided by Professional
• Dynamic interference checking to find and display interference quickly during motion playback
• Matrix clearance analysis to perform complete analysis on large, 3D product databases
• Create and manage part constraints
• 3D grouping
• Filter queries
• Area and mass properties reports
• 3D alignment
• Volume clipping
• Hide obscuring geometry
• Color application
• Part editing
  o B-Rep face reversing
  o Re-tessellation
  o Decimation
  o Visibility simplification
  o JtOptimize

Mockup supports the following optional modules:
• Visualization Illustration
• Concept Desktop
• Concept Showroom
• Variation Analysis
• Quality Producer (Windows only)
• Jack
• ECAD Viewer
• Visual Reports
• .vfz collaboration file authoring
• ADAMS conversion (Windows only)
• STEP file export
• MetaVPDM
• Analysis
• Animation authoring
• Path planning
• ClearanceDB

Mockup supports the following optional file converters:
• IGES
• STEP
• DXF

Convert and Print

Convert and Print are flexible command-line conversion and print software utilities that augment the power of the Lifecycle Visualization products. Both applications provide you with tools to convert and print many file formats, resulting in consistency and efficiency.

The key advantage to Convert and Print is their capacity to integrate effectively both native and external file format converters. By integrating the converters, you can convert original files directly into a supported file format. You can also print these files directly into the format required by your printer.
Chapter 3: Deprecated platform announcement

Siemens PLM Software will discontinue support for Teamcenter lifecycle visualization ClearanceDB (client and proxy tiers) on all Sun platforms, starting with Teamcenter 12.x. This includes Clearance Calculator (ClearanceExe), ClearanceDB Client (ClearanceDbClient), and ClearanceDB Proxy (ClearanceDbProxyServer and ClearanceDbProxyClient). ClearanceDB Server tier support on Sun will remain consistent with Teamcenter Server platforms.
Chapter 4: What's new

What's new overview
This Teamcenter lifecycle visualization release includes the following new features and enhancements. Descriptions are categorized by product level and optional module.

New features for Standard

Sort parts in part reports
You can now sort the parts in part reports by clicking the headers of attribute columns to sort them in ascending or descending order. This makes it easier to review report data.

Set measurement display units to match model units
In measurement preferences, you can set the measurement Display units to automatically use the value set for Model units.

New features for Professional

Immersive mode enhancements
The following enhancements are added for working with immersive devices:

• You can more easily configure zSpace, Oculus Rift, and HTC Vive devices by loading the configuration file provided with your installation. The configuration file includes the paths to the VCD and SCD files.

• You can configure the immersive menu to use the basic or advanced menu, or you can use a custom menu.

• You can capture and apply snapshots in immersive mode.

• To assist in selecting part features for measurements, selection modes are displayed on a radial menu.

• Measurement annotations, created either on the desktop or in immersive mode, are displayed as 3D labels when in immersive mode. The labels appear in the same plane as the anchor point. This enables the content to be readable from your current position. The viewing direction is determined by the camera at the foot location.
Assembly-level coloring in visual reports

To allow partially visible assemblies to be considered as visible, you can set a preference so when a visual report is generated, partially visible assemblies receive assembly-level coloring.

New features for Mockup

Sort and reorder part groups

You can change the order of part groups in the following ways. This makes it easier to review group information.

- Right-click anywhere on the Groups page, and choose Sort—Ascending or Descending.
- Drag a group to move it to a different location in the list. To move multiple groups, hold Shift or Ctrl as you select the groups.

Clearance analysis enhancements

The following enhancements are added to clearance analysis for better usability:

- You can set a preference to load either the clearance results related to items in the current document or results for the entire product. By choosing to load only the results for the current document, which is the default setting, results load more quickly and you see only the results you are currently interested in analyzing.

- You can control how clearance calculations are performed for 4G data with multiple subsets.

  In the Subsets section of the Clearance Calculator Settings dialog box, select one of the following options to control how 4G data with subsets is calculated:

  - Only allow issues within each subset
  - Only allow issues between subsets
  - Allow all issues regardless of subset

New features for Variation Analysis

Point Measurement Generator

Use the new Point Measurement Generator command to create multiple point measurements using existing points from the following process tree elements:

- Assembly
- Part
- Measurement group node
• Feature
• Feature group node

When you use the command, available points are automatically displayed in the list box, along with their nominal and normal vector values.

(1) Naming
Names the resulting measurement operations by inheriting the point names, or by using a name prefix you specify.

(2) Point Selection
Filters point names in the list box based on the text string you enter for the selection filter.

(3) List box
Lists the available points after any selection filter is applied.

(4) Point Normal Vector
 Resets the normal vector of selected points to their nominal vector direction.

(5) Vector & Spec Limit Assignment
Assigns the specified direction vector and specification limits to selected points.

(6) Apply and Exit buttons

Apply applies the current measurement properties, and then lets you continue creating additional measurements. Exit closes the dialog box, so you must use the Point Measure Generator command again to create additional measurements.

Enhancement to importing a process document from a text file

When you import a text file to a process document, the following items are now imported from the text file:
• Classic flex assembly operations
• Part mesh properties
• Pattern features
• FEA points with the correct icon

**Point measurement enhancement**

The point measurement command is enhanced so that you can specify values to define the I, J, and K coordinates for the direction vector.

You can also define a vector by selecting up to three features.
Virtual clearance measurement enhancement

When you create a virtual clearance measurement to evaluate the minimum or maximum clearance between a pin feature and a hole feature, you can now select a two-way pin as the feature from which the measurement is made.

Custom measurement operation enhancement

The custom measurement operation is enhanced so you can define the X, Y, and Z point coordinates for the leader line anchor.

You can also define the leader line anchor point by selecting a location in the Viewing window.
Position characteristic for plane features

When creating the first frame of a feature control frame for a plane feature, you can now apply the position characteristic.

Move custom assembly operation enhancement

The move custom assembly operation now supports up to 50 entries.
Link features and tolerances to DPV Lite measured data

Use the new Link to DPVLite Measured Data command to link a Variation Analysis feature and tolerance to a DPV Lite feature attribute so you can use the measured data distributions instead of the design intent distributions.

After you link a part's feature and tolerance to a DPV Lite feature attribute in the Link Feature Tolerances To DPVLite Attributes dialog box, the distributions are updated in the feature’s properties dialog box to reflect the new distribution.
Creating surface mesh for minimum feature clearance and variation visualization

Use the new Mesh Derived from JT option to create a surface mesh in Variation Analysis using JT XTBrep data.

The resulting mesh is stored in a DAT file in the location you specify, and can be used in a minimum feature clearance measurement operation. Previously, you could only associate a minimum feature clearance measurement to a mesh by linking it to an external Nastran-based mesh.

You can find the Mesh Derived from JT option on the Mesh tab of the Part Properties dialog box.
When the **Mesh Derived from JT** check box is selected:

- You can set the **Chord Length** and **Sag** options for more control over the resulting surface mesh.
- You cannot specify an external mesh to link to the part, so the following options are unavailable:
  - User Provided Mesh
  - File Browser
  - Mesh File Location
  - Mesh section options
Chapter 5:  Supported platforms and locales

**Supported platforms**

For information about the platforms on which you can run Teamcenter lifecycle visualization, see the Hardware and Software Certifications page on GTAC: https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

**Supported locales**

The Lifecycle Visualization application and help are localized for the following languages:

- Chinese (Simplified and Traditional)
- Czech
- French
- German
- Italian
- Japanese
- Korean
- Polish
- Portuguese (Brazil)
- Spanish
- Russian

Some optional modules are available in English versions only, including:

- ClearanceDB
- Convert and Print
- Jack
- Quality Producer
- Variation Analysis

**Note**

- A separate installer is required for each language version of the help.
- Because of operating system limitations, Teamcenter lifecycle visualization does not support non-ASCII characters, including 8-bit accented Western European and multi-byte characters, in file names.
Chapter 6: System requirements

General system requirements

Performance is directly related to system processor speed, RAM, and your video card. Although Lifecycle Visualization will run if your system meets the minimum requirements described in this section, your machine should be considerably more powerful for you to get the full benefit of the visualization features.

Minimum required system

For 3D models, 2D images, and ECAD images, your system should have a 1 GHz or better processor, 1 GB RAM, 2 GB of virtual memory, and a supported graphics card with 128 MB of dedicated video RAM and support for OpenGL 2.1 or greater.

Minimum recommended system

For 3D models, 2D images, and ECAD images, your system should have a 2 GHz or better 64-bit processor, 4 GB RAM, 6 GB virtual memory, and a supported graphics card with 256 MB of dedicated video RAM and support for OpenGL 3.2 or greater. For more information on which graphics adapters are supported, see Graphics hardware requirements.

Note


These are only recommendations. For information on officially supported workstations, video cards, and drivers, see the Hardware and Software Certifications page on GTAC: https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

License server requirements

Lifecycle Visualization products use the Siemens PLM Software Common Licensing Server for served licenses.

For information about Siemens PLM Software that supports Teamcenter 11.5 lifecycle visualization, see the Hardware and Software Certifications page on GTAC: https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

Teamcenter community collaboration visual conferencing requirements

To use Teamcenter 11.5 lifecycle visualization with Teamcenter community collaboration visual conferencing you must have Teamcenter community collaboration conference server 11.1 or higher.
Teamcenter community collaboration visual conferencing is not supported on older conferencing servers.

**Graphics hardware requirements**

Supported graphics adapters for use with Teamcenter lifecycle visualization include the following professional 3D graphics adapters with their professional drivers:

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA</td>
<td>Quadro, QuadroFX, Grid</td>
</tr>
<tr>
<td>AMD</td>
<td>FireGL, FirePro</td>
</tr>
<tr>
<td>Intel</td>
<td>HD 4600 and newer</td>
</tr>
</tbody>
</table>

For full confidence that all of the advanced features of Teamcenter lifecycle visualization are displayed, including effects such as high-quality transparency, shadows, mirrors, CAE analysis results, intersection volumes, and other features requiring advanced graphics capabilities, use a certified system. Siemens PLM Software and our OEM partners rigorously test specific graphics adapters and drivers on a select set of workstations. Graphic adapters and drivers that pass are certified for use with a particular version of Teamcenter lifecycle visualization.

For information about certified systems, see the Hardware and Software Certifications page on GTAC ([http://www.plm.automation.siemens.com/locale/support/gtac/certifications.shtml](http://www.plm.automation.siemens.com/locale/support/gtac/certifications.shtml)) and follow the link to *Hardware (Graphics Card) Certifications*.

**Note**

Starting with Lifecycle Visualization version 10.1, if your graphics card supports OpenGL 3.2 or later, Lifecycle Visualization uses advanced OpenGL features to improve 3D rendering performance, including making use of memory on the graphics card. If you work with large models, we recommend graphics cards with 2GB or 4GB of GPU memory, or more. While exact memory requirements are highly situation specific, a rough guideline for required graphics card memory is 1 GB of graphics memory for every 2 GB of loaded geometry data.

**Consumer line and 2D graphics adapters**

We do not recommend consumer lines of graphics adapters. These adapters and drivers are designed for playing games and emphasize frame rate over correctness. Drivers for consumer graphics are serviced by driver development and ISV partner teams separate from those for professional 3D adapters.

However, even these video adapters, if you have the most current graphics driver, usually work at a reduced effects level with Lifecycle Visualization. It may be necessary to reduce the performance settings.
Note
When the OpenGL level of a graphics adapter is not capable of rendering an advanced visualization effect, the visual effect is silently omitted.

Some graphics adapters, especially those manufactured before 2008, contain issues that prevent Lifecycle Visualization from displaying certain specific features properly, regardless of their OpenGL support level claims.

Resolving graphics adapter issues
You are encouraged to report graphics display problems found on recommended and certified hardware to http://www.siemens.com/gtac. We attempt to reproduce the problem. If a reproducible problem is determined to lie within Lifecycle Visualization software, we fix it directly; if a problem is found with the graphics driver, we work with the graphics vendor to isolate the issue and assist them as necessary to produce a driver patch.

We do not attempt to resolve problems that cannot be reproduced on recommended or certified hardware; we advise you to take such issues directly to the graphics adapter manufacturer.

Help requirements
To run the Teamcenter lifecycle visualization help, the following requirements must be met:

• Windows:
  o Internet Explorer – 8 or higher
  o Firefox – 16 or higher
  o Chrome – latest release

• Linux:
  o Firefox latest release

• Mac OS X:
  o Safari – latest version
  o Chrome – latest version

• The Siemens PLM Documentation Server requires a supported 64-bit Java Runtime Environment (JRE) on the PLM Documentation Server host. The PLM Documentation Server does not support 32-bit Java.

  Make sure a supported 64-bit JRE is installed on your PLM Documentation Server host.

• To watch videos and simulations, the Adobe Flash Player version 10 or later is required. You can download the latest version of the player from this location:
  http://get.adobe.com/flashplayer/
Some portions of the help are in the PDF format, which requires Adobe Acrobat Reader (any version). You can download the reader from this location:

http://get.adobe.com/reader/

Note
The help files are no longer packaged with the Teamcenter lifecycle visualization installer. To install the help locally, you must install the Siemens PLM Documentation Server and the Teamcenter lifecycle visualization help, which are installations separate from the installation of Teamcenter lifecycle visualization. You must also set the port and server for help access for clients during the product installation or after the product installation. A separate installer is available for each language version of the help. Alternatively, you may access the help from the Siemens PLM Software Doc Center site, which you are directed to when you select the Help commands in the software after you choose not to install help during the software installation.

Firefox caveats
Firefox recommends that users update to the latest version for security issues surrounding Java. They do not recommend using older versions of Firefox due to these issues. See the following for more information:


Chrome caveats
By default, Chrome does not launch local files (e.g. file:///). To enable this, users have to start Chrome from the command line with the --allow-file-access-from-files switch. One source for how to do this is: http://www.askyb.com/chrome/open-local-file-in-google-chrome/

PDF requirements
To view, mark up, and print PDF and Postscript files on Mac and Linux systems, you must install and use Ghostscript.

1. You can navigate to the following Web site to download and install the Ghostscript software:
   https://download.industrysoftware.automation.siemens.com/open-source/ghostscript

2. After installing Ghostscript on Mac or Linux systems, add the following to your vvcp.darwin.cfg or vvcp.linux.cfg file in the <installation_directory>/app_defaults/ directory:
   *PSPath: <path to the ‘gs’ executable>

   For example, add *PSPath: /usr/apps/gs864/bin/gs.

Ghostscript is also required to work with Postscript files on Windows systems. You can download the Windows version from the site shown above.
Tip
To configure Ghostscript to use system fonts on Windows, install Ghostscript before you install Lifecycle Visualization.

IDW requirements
To work with Autodesk Inventor .idw 2D files, you must have one of the following:

• Autodesk Inventor
• Autodesk Inventor View, a freely distributed application available from Autodesk
• Design Tracking, a freely distributed utility available from Autodesk

Note
• Support for Autodesk Inventor .idw files depends on the version of the Autodesk Inventor, Autodesk Inventor View, or Design Tracking that you have installed. For example, if you have Design Tracking 7, then Inventor 5.3 through 7 files are supported. If you have Autodesk Inventor View 11, then Inventor 5.3 through 11 files are supported.
• Autodesk Inventor .idw files prior to version 5.3 are not supported.

ADAMS conversion requirements
The ADAMS conversion feature, which converts RES files to the VFM motion file format, requires the Professional or Mockup product configuration, as well as an additional license. It is supported on Windows only.

Visualization Illustration requirements
To install Visualization Illustration, when you install Teamcenter lifecycle visualization by right-clicking the setup.exe, you must select Run as an Administrator. This is necessary to register VisioHostApp in Windows.

Visualization Illustration is supported on Windows only (Windows 7 or Windows 10), and requires one of the following:

• Visio 2010 with Service Pack 2, either the 32-bit or 64-bit version
• Visio 2013 or 2016 with the latest patch, either the 32-bit or 64-bit version

Authoring Visio-based work instructions in Teamcenter Manufacturing is supported only with 64-bit Visio 2010.

Standard, Professional and Premium editions of Visio are supported.
Convert and Print requirements

- The Convert and Print Office Automation feature requires Microsoft .NET Framework. Version 4.5.x is recommended.


- To view, convert, and print Microsoft Office files, you must have Microsoft Office installed.

ClearanceDB requirements

For information about the requirements for ClearanceDB, see ClearanceDB Administration in the Teamcenter lifecycle visualization help.

Interoperability with other software

For information about Siemens PLM Software that supports Teamcenter 11.5 lifecycle visualization, see the Hardware and Software Certifications page on GTAC: https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.

Teamcenter client communication system (TCCS) requirements

The Teamcenter client communication system (TCCS) manages communication and file transfers between Teamcenter clients and servers. TCCS contains the Teamcenter Server Proxy (TSP) application which manages HTTP/S communication with a Teamcenter server and provides support for forward proxy, reverse proxy, and Kerberos authentication. TCCS also contains the FMS client cache (FCC), which uploads files from your workstation to a Teamcenter volume and also downloads requested files from the volume to your workstation. The Teamcenter lifecycle visualization integration with Teamcenter requires an FCC to transfer volume data between Teamcenter and the viewer.

TCCS is normally installed with the Teamcenter rich client. If the Teamcenter rich client is installed on your machine, most likely no additional installation steps are necessary. If you do not have the Teamcenter rich client installed, but you need to transfer volume data between Teamcenter and the viewer, you can you can download the TCCS installer from the GTAC site http://www.siemens.com/plm/support. For more information, see the Lifecycle Visualization Installation guide.

Note

An FCC is required for Teamcenter 8 onwards. Although an FCC is not required for Teamcenter 2007, it is recommended.

For information on installing TCCS with the Teamcenter rich client, refer to Windows Clients Installation, Linux Clients Installation, or Macintosh Clients Installation within the Teamcenter documentation.
# Chapter 7: Resolved Problem Reports

Customer problem reports (PRs) resolved for Teamcenter 11.5 lifecycle visualization include:

<table>
<thead>
<tr>
<th>PR</th>
<th>Product</th>
<th>Category</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>8357244</td>
<td>VISVIEW</td>
<td>2D_FILE_DWG/DXF</td>
<td>Opening a DXF file with embedded TIF does not work.</td>
</tr>
<tr>
<td>8542814</td>
<td>VISVIEW</td>
<td>2D_FILE_DWG/DXF</td>
<td>nx2dvg image file viewing issue.</td>
</tr>
<tr>
<td>7931407</td>
<td>VISVIEW</td>
<td>3D_FILE_JT</td>
<td>File&gt;Export: Assembly level JT contains geometry of sub-assemblies.</td>
</tr>
<tr>
<td>8992586</td>
<td>VISVIEW</td>
<td>3D_FILE_JT</td>
<td>Import JT files exported from TcVis 11, appears in HyperMesh as meters.</td>
</tr>
<tr>
<td>9005998</td>
<td>VISVIEW</td>
<td>3D_FILE_JT</td>
<td>Unexpected line segments on export with Draw feature lines activated.</td>
</tr>
<tr>
<td>9008627</td>
<td>VISVIEW</td>
<td>3D_FILE_JT</td>
<td>Assigned materials in exported JT are suppressed by a newly generated material.</td>
</tr>
<tr>
<td>8366380</td>
<td>VISVIEW</td>
<td>3D_FILE_PRT</td>
<td>Missing NX version support info in documentation for embedded Visualization.</td>
</tr>
<tr>
<td>8997311</td>
<td>VISVIEW</td>
<td>3D_MARKUP</td>
<td>Position of JT part is changed after adding markup.</td>
</tr>
<tr>
<td>9004270</td>
<td>VISVIEW</td>
<td>3D_MARKUP</td>
<td>Callout leader lines do not attach at center of circle callouts.</td>
</tr>
<tr>
<td>9034589</td>
<td>VISVIEW</td>
<td>3D_MARKUP</td>
<td>VFFrame in TcVis when creating a 3D markup with a specific JT file.</td>
</tr>
<tr>
<td>9049426</td>
<td>VISVIEW</td>
<td>3D_MARKUP</td>
<td>Some automatically created markup leaders don't point to geometries.</td>
</tr>
<tr>
<td>7461438</td>
<td>VISVIEW</td>
<td>3D_MEASUREMENT</td>
<td>Long delay after moving part with several dynamic measurements.</td>
</tr>
<tr>
<td>7662879</td>
<td>VISVIEW</td>
<td>3D_MEASUREMENT</td>
<td>No update of a face's normal measurement after moving a corresponding coordinate system.</td>
</tr>
<tr>
<td>9005950</td>
<td>VISVIEW</td>
<td>3D_MEASUREMENT</td>
<td>Cannot go back to millimeters once Model unit is changed in measurement preferences.</td>
</tr>
<tr>
<td>9019470</td>
<td>VISVIEW</td>
<td>3D_MEASUREMENT</td>
<td>&quot;Display the X, Y, Z, delta values&quot; measurement preference not saved.</td>
</tr>
<tr>
<td>9091047</td>
<td>VISVIEW</td>
<td>3D_RENDERING</td>
<td>Security marking showing geometry at same time as marking.</td>
</tr>
<tr>
<td>7768742</td>
<td>VISVIEW</td>
<td>3D_SELECTION</td>
<td>Motion is incorrect when &quot;show end items&quot; and &quot;show leaf nodes&quot; preferences are activated.</td>
</tr>
<tr>
<td>8317545</td>
<td>VISVIEW</td>
<td>3D_SELECTION</td>
<td>When the selection filter is an asterisk, dynamic highlight does not highlight the selected arc.</td>
</tr>
<tr>
<td>8801888</td>
<td>VISVIEW</td>
<td>3D_SELECTION</td>
<td>Use Approximate on a double measurement uses the original location of x-formed part.</td>
</tr>
<tr>
<td>9084130</td>
<td>VISVIEW</td>
<td>APPEARANCES</td>
<td>The API getSubPartNominalMaterialRefs does not always work as expected.</td>
</tr>
<tr>
<td>8362333</td>
<td>VISVIEW</td>
<td>CLEARANCE</td>
<td>Documentation not up-to-date: The preferences for &quot;Dynamic Clearance&quot; moved.</td>
</tr>
<tr>
<td>8925941</td>
<td>VISVIEW</td>
<td>CLEARANCE</td>
<td>Dynamic clearance is slower with leaf component option.</td>
</tr>
<tr>
<td>PR</td>
<td>Product</td>
<td>Category</td>
<td>Summary</td>
</tr>
<tr>
<td>------</td>
<td>---------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>9077247</td>
<td>VISVIEW</td>
<td>CLEARANCE</td>
<td>Matrix clearance and results analysis is 2 times slower in 11x than 10x.</td>
</tr>
<tr>
<td>8974648</td>
<td>VISVIEW</td>
<td>CROSS_SECTION3D</td>
<td>Position Plane can't be controlled after switching MB1 and MB2.</td>
</tr>
<tr>
<td>9020663</td>
<td>VISVIEW</td>
<td>FRAMEWORK_COMMS</td>
<td>Direct Model JT shortcuts broken using TcVis 11.</td>
</tr>
<tr>
<td>9104835</td>
<td>VISVIEW</td>
<td>GDT_MARKUP</td>
<td>Symbol is garbled in TcVis GD&amp;T markup.</td>
</tr>
<tr>
<td>9093863</td>
<td>VISVIEW</td>
<td>HELP</td>
<td>Quick Color tool - need documentation about materials to single faces in JT without BRep.</td>
</tr>
<tr>
<td>9097317</td>
<td>VISVIEW</td>
<td>INSPECTOR</td>
<td>Configuration of JT Inspector is not entirely restored on next open.</td>
</tr>
<tr>
<td>9075303</td>
<td>VISVIEW</td>
<td>INSTALLATION</td>
<td>VisCustomize fails to execute in TcVis 11.4 &amp; 11.5.</td>
</tr>
<tr>
<td>9072105</td>
<td>VISVIEW</td>
<td>MODELVIEW_GALRY</td>
<td>PMI preference to show model views as tree by default does not work.</td>
</tr>
<tr>
<td>9012825</td>
<td>VISVIEW</td>
<td>PART_REPORT</td>
<td>Part Report &gt; Markup callout numbers are not in sequential order.</td>
</tr>
<tr>
<td>9078675</td>
<td>VISVIEW</td>
<td>PATH_EXTRACTION</td>
<td>Path Planner Showing a Collision P1 and P2 when isn't a collision.</td>
</tr>
<tr>
<td>3056405</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>PMI selection not working in 3D viewing window.</td>
</tr>
<tr>
<td>7765596</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Multiple Entity Mode doesn't support custom symbol PMI.</td>
</tr>
<tr>
<td>8824688</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Contents of &quot;Model Views&quot; and &quot;PMI Tree - Model Views&quot; are not equal.</td>
</tr>
<tr>
<td>8922462</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Multi-select in the PMI tree doesn't work.</td>
</tr>
<tr>
<td>8972822</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Initial display of snapshot incorrectly applies section cut to some parts.</td>
</tr>
<tr>
<td>8972852</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Snapshot section cuts created with Vis 9.1.2 are not rendered with Vis 11.2.3.0.</td>
</tr>
<tr>
<td>8997831</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>ModelView Palette refresh and the palette cursor jumps to end of thumbnails.</td>
</tr>
<tr>
<td>9021251</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Export and Print of PMI properties does not work as expected.</td>
</tr>
<tr>
<td>9021836</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>Activating Manufacturing tab in Vis 11.2.3.1 causes spike in CPU usage.</td>
</tr>
<tr>
<td>9097279</td>
<td>VISVIEW</td>
<td>PMI</td>
<td>PMIs do not export as expected on JT Export.</td>
</tr>
<tr>
<td>3056502</td>
<td>VISVIEW</td>
<td>PRINT/PLOT</td>
<td>Print using 1:1 scale hangs TcVis on Win10,</td>
</tr>
<tr>
<td>3056542</td>
<td>VISVIEW</td>
<td>PUBLISH</td>
<td>Markups not retained correctly in Asset/Technical Illustration.</td>
</tr>
<tr>
<td>3056543</td>
<td>VISVIEW</td>
<td>PUBLISH</td>
<td>Asset Capture causes view window to minimize.</td>
</tr>
<tr>
<td>3056892</td>
<td>VISVIEW</td>
<td>SESSION</td>
<td>TcVis prompts to find markup layer when saved in session package.</td>
</tr>
<tr>
<td>9018080</td>
<td>VISVIEW</td>
<td>SESSION</td>
<td>TcVis &quot;Save Session&quot; changes VF session to VFZ session package.</td>
</tr>
<tr>
<td>3056519</td>
<td>VISVIEW</td>
<td>VISUAL_REPORT</td>
<td>Visual Reports - Assembly level coloring not working on partially loaded assemblies.</td>
</tr>
<tr>
<td>3056644</td>
<td>VISVIEW</td>
<td>VR_DEVICES</td>
<td>VisConcept - Immersive 3D measurement not near part and cannot be repositioned.</td>
</tr>
<tr>
<td>3056646</td>
<td>VISVIEW</td>
<td>VR_DEVICES</td>
<td>VisConcept - Immersive 3D markup not near part and cannot be repositioned.</td>
</tr>
<tr>
<td>PR</td>
<td>Product</td>
<td>Category</td>
<td>Summary</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>9037603</td>
<td>VISVIEW</td>
<td>LEGACY_VSA</td>
<td>Custom measurement math equation records wrong output in doc summary .txt file.</td>
</tr>
<tr>
<td>3056469</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Creating a stepped planar feature.</td>
</tr>
<tr>
<td>3056512</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>VisVSA 11.3 import of FEA boundary condition node vectors.</td>
</tr>
<tr>
<td>3056699</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>VSA - Crash when using Model Cleanup tool.</td>
</tr>
<tr>
<td>3056769</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Missing to identify a flexible part within the subassembly.</td>
</tr>
<tr>
<td>3056770</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>VSA does not recognize both parts as flexible.</td>
</tr>
<tr>
<td>9069997</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>VA: Large model crashes.</td>
</tr>
<tr>
<td>9084186</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>VA - Flatness tolerance application seems inconsistent in HLM.</td>
</tr>
<tr>
<td>9090755</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Mesh displaced from JT.</td>
</tr>
<tr>
<td>9116948</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>VSA: different result in 11.4.</td>
</tr>
</tbody>
</table>
Chapter 8: Enhancement Requests

Customer enhancement requests (ERs) implemented for Teamcenter 11.5 lifecycle visualization include:

<table>
<thead>
<tr>
<th>ER</th>
<th>Product</th>
<th>Category</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>2228652</td>
<td>VISVIEW</td>
<td>ASSEMBLY_TREE</td>
<td>Resolve the copy and paste of alternate hierarchy in reverse order.</td>
</tr>
<tr>
<td>8979030</td>
<td>VISVIEW</td>
<td>AUTOMATION_API</td>
<td>API in VisAutomation to extract part inertia.</td>
</tr>
<tr>
<td>3054401</td>
<td>VISVIEW</td>
<td>GROUPS</td>
<td>Reorder groups.</td>
</tr>
<tr>
<td>5819060</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Custom measurement.</td>
</tr>
<tr>
<td>7898596</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Expandable &quot;Where Used&quot; dialog box.</td>
</tr>
<tr>
<td>8815092</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Display position of custom measurements.</td>
</tr>
<tr>
<td>9069066</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>Support for 2-way pin in minimum virtual clearance.</td>
</tr>
<tr>
<td>9104227</td>
<td>VISVSA</td>
<td>VISVSA</td>
<td>PMI on JT not being recognized for feature creation - multi-leaf.</td>
</tr>
</tbody>
</table>
Chapter 9: Issues and workarounds

UNIX session ends when loading JT data

**Problem**
When working in UNIX and loading JT data in an embedded viewer in Teamcenter, the session ends.

**Workaround**
Use the latest version of the NVIDIA driver.

CAE legend annotation does not appear properly

**Problem**
When exporting CAE data into the JT format using NX12, if you choose the old style JT CAE format (prior to TcVis 11.0), the legend annotation does not appear properly when opening the JT file in TcVis 11.0 or later.

**Workaround**
Choose the new style JT CAE format (TcVis 11.0 and later) when exporting CAE data into JT in NX12.

Parts not positioned correctly for model views in session packages

**Problem**
When you load session packages that have model views applied, upon reload of the session package, parts may not be positioned correctly for model views that enforce part transforms.

**Workaround**
Use *Reset Part Position* and reapply the model view.

Thumbnails of model views not captured

**Problem**
When you load a session file that contains model view palettes, and a session file containing a model view palette in Teamcenter is saved using the static configuration, the thumbnails of the model views on the palettes are not captured. You may see ModelView palette entries that are empty.

**Workaround**
Save the session as dynamic references.

NX PRT loading support

**Problem**
Teamcenter Visualization 11.5 supports NX12 PRT loading on Windows only.

**Workaround**
For other platforms, TcVis 11.5 supports up to NX11.

Cannot rotate grouped shapes from a stencil list

**Problem**
Due to a Visio 2013 and 2016 issue, you cannot rotate grouped shapes that are added from a stencil list.
## Cell borders missing in graphical reports

**Problem**
Due to a Visio issue, cell border lines are missing in tables in DPV graphical reports when printed in PDF format.

**Workaround**
None

## Some charts and tables missing in graphical reports

**Problem**
Some charts and tables are missing in printed DPV graphical reports when printed in PDF format. This happens when the assets are overlaid over another in the Visio document.

**Workaround**
In **Print Setup** on the **Advanced** tab, select **Print as image**.

## Saving graphical reports as text doesn't save chart and table text

**Problem**
Due to a Visio and/or Acrobat issue, chart and table text is missing in DPV graphical reports when the PDF is saved as text.

**Workaround**
In the open PDF file, select all text and copy it in a text editor.
- or -
Use the feature in PDF-XChange Editor to convert the PDF to text.

## Visualization Illustration stops responding when working with gradients on shapes

**Problem**
Teamcenter Visualization stops responding when you work with the **Shapes** context menu and modify the gradient.

**Workaround**

## Values in Variation Analysis not retained or are corrupted

**Problem**
Values keyed-in in Variation Analysis edit boxes are not retained or are corrupted.

**Workaround**
Install the Microsoft windows patch KB4041681.

## JT Utilities Integration with Teamcenter is obsolete

**Problem**
The integration of JT Utilities with Teamcenter is removed from Teamcenter 11.4 and later versions. You may still use JT Utilities as a standalone tool or as an integration tool with any product where this utility is properly configured and integrated. Standalone JT Utilities is available for download from the GTAC download site, under Teamcenter Visualization→JT Translators→PLM Vis:
https://download.industrysoftware.automation.siemens.com/
Issues and workarounds

Workaround: Siemens PLM Software recommends opening JT assemblies with the Lifecycle Viewer or the embedded viewers in Teamcenter.

Generating a DPV template from a technical portfolio is slow

Problem: Generating a DPV template from a technical portfolio is slow.

Workaround: If Visio is used in VisAutomationServer for updating the DPV templates, set the environment variable `TCVIS_VISAUTOMATIONSERVER_VISIO` to `true` on the client machine where DPV templates are created.

Text not selectable in Visualization Illustration raster quality images

Problem: In Visio 2013 or earlier, Visualization Illustration produces raster quality images and thus text is not selectable.


Shapes from File menu is not supported with Office 365

Problem: Visualization Illustration with the Office 365 version of Visio does not support the Shapes option from the File menu.

Workaround: Use the ribbon interface to choose Home tab→Stencil group→Shapes. If shapes do not appear, open shape stencils from Visio 2016 once, close Visio, and then start Teamcenter Visualization.

Error when opening HTML file published from a technical portfolio

Problem: Due to added Java security restrictions, opening an HTML file published from a technical portfolio may cause an error message.

Workaround: Add the local folder where the HTML file is stored to the Exception Site List in the Java Control Panel, as file:\\D:\mydir/.

Styles menu in Visualization Illustration causes program to stop responding

Problem: The program stops responding when you work with the Styles context menu, which is available when you select a 3D geometry asset or a shape in an illustration.

Workaround: For formatting, from the Application toolbar, choose Menu → Format→ Text, Line, or Fill.

Help not compatible with older Documentation Server versions

Problem: The Teamcenter 11.5 lifecycle visualization help is not compatible with versions 1.0 and 2.0 of the Siemens PLM Documentation Server.
Workaround: Install version 2.1 of the Siemens PLM Documentation Server, available on GTAC.

Not responding message appears during clearance analysis

Problem: When you perform a clearance analysis in which the part pair analysis takes several minutes, when you click in the main window, the message Application not responding appears.

Workaround: Click Wait for the program to respond, and the calculation will finish.

JT-STEP Bi-Directional Translator support issue

Problem: The integration to JT-STEP Bi-Directional Translator does not support the configuration control writeWhichFiles for a combination of values AP242XML,JTPARTS in interactive and command line mode.

Workaround: None

Measurement operation navigation buttons not functional in Variation Analysis

Problem: The measurement operation navigation buttons are not functional if there is a general surface feature that does not contain a sub-feature point associated with a minimum feature clearance measurement operation.

Workaround: Add at least one sub-feature point to the general surface feature.

Thrustline attached with a leaf component not repositioned correctly

Problem: Thrustline attached with a leaf component may not be repositioned correctly upon load if the position of the leaf component's parent is changed due to new revision.

Workaround: None

Save not deactivated when technical illustration with file is saved

Problem: If a file is inserted into a technical illustration, and the technical illustration is saved, the Save button is not deactivated.

Workaround: Close the technical illustration and click Yes when the message appears, Do you want to Save changes to the file?

Mismatch between outline geometry and shaded image

Problem: When a 3D geometry asset is created without enabling page extents using the Shaded with Outline option, and then asset is shown both in Illustration with the Show Shaded with Outline option, a mismatch may occur between the outline geometry and the shaded image.
Workaround: Create 3D geometry assets with page extents enabled. If this issue occurs with existing 3D geometry assets created without page extents, update the asset.

**Loading a file from Teamcenter may fail if SSO is enabled**

**Problem:** When loading a file from a Teamcenter server to Teamcenter lifecycle visualization running in a cluster system, if the server is configured with single sign-on (SSO), the viewer running on the secondary system may fail to load the data.

**Workaround:** Teamcenter lifecycle visualization running on the secondary system may have different environment variable settings as the one running on the primary system. Do the following:

1. Create a text file, for example:
   
   `C:\tcvis_cluster_user_env_vars.txt`

2. Set the system environment variable to point to the file, for example:
   
   `TCVIS_CLUSTER_USEREnv_VARS=C:\tcvis_cluster_user_env_vars.txt`

3. Identify the following environment variables used by Teamcenter lifecycle visualization running on the primary machine:
   
   ```
   APPDATA
   USERPROFILE
   USERNAME
   ```

4. Add the information to text file. For example:
   
   ```
   APPDATA=C:\Users\PV\AppData\Roaming
   USERPROFILE=C:\Users\YourUserName
   USERNAME=YourUserName
   ```

5. Restart the secondary system.

**IPv6 for sockets**

**Problem:** The rich client embedded viewer does not support IPv6 for sockets. In this instance, the viewer will attempt to force an IPv4 connection.

**Workaround:** If using IPv6, ensure that IPv4 sockets are still enabled.
Chapter 9: Issues and workarounds

**VBScript in Internet Explorer**

**Problem** Internet Explorer support for VBScript has changed. The changes may impact existing customer processes and deployments.

**Workaround** For details, refer to the information, *VBScript in Internet Explorer*, located in this file in the installation Examples folder: Automation\Documentation\ref_files\vbscript.htm

**AutoCorrect options do not appear in Visualization Illustration**

**Problem** When you use 64-bit Visio, the AutoCorrect options are not available. These options are available from the Application toolbar when using 32-bit Visio:

- Menu→Tools→Options→Proofing→AutoCorrect Options
- Menu→Tools→Auto Correct Options

**Workaround** Open Visio, and set the options using Tools→Options→Proofing→AutoCorrect Options.

**Dotted line appears in SVG file in technical illustration**

**Problem** When you open an SVG file in Visualization Illustration, a dotted line may appear.

**Workaround** The line represents a page break and can be ignored. It does not appear in printed or PDF output.

**Linux embedded viewer dialog boxes appear behind the rich client window**

**Problem** On Linux, embedded viewer dialog boxes may appear behind the main rich client application window.

**Workaround** Use Gnome Window Manager. Most other Linux window managers do not work correctly.

**UI text does not display correctly for non-English locales on Linux**

**Problem** Teamcenter lifecycle visualization interface text does not display correctly for non-English locales on Linux.

**Workaround** You must specify the language at the login screen to ensure the X Server loads the correct fonts.

If the *Font Creating Failed* error appears, refer to the workaround below for the *Missing UI text on Linux* issue.

**Error when converting a DWG file with an embedded OLE object to PDF**

**Problem** An error message appears when you attempt to convert a DWG file with an embedded OLE object to PDF.
Workaround

Disable macros and change resource settings:

1. In Excel, choose File→Options.
2. In the Excel Options dialog box, choose Trust Center.
3. In the Microsoft Excel Trust Center section, click Trust Center Settings.
4. Choose Macro Settings.
5. Select Disable all macros without notification.
6. You may need to set the following resource settings in the vvcp.ini file. These settings require less memory when converting the file.
   - DwgOLERasterQuality=0
   - DxfOLERasterQuality=0

Some CGM files generated by Catia V5 fail to display the image

Problem

Some CGM files generated by Catia V5 with embedded raster data fail to display the image when loaded into Teamcenter lifecycle visualization. This is because some CGM data generated by Catia V5 can be invalid based on the CGM specification. The invalid data may not impact the rendering of the image, but any found error can cancel the processing of the image.

Workaround

If the CGM specification check is overridden, the image may still display properly. To enable the override, while Teamcenter lifecycle visualization is not running, create an environment variable named TCVIS_IGNORE_CGM_RASTER_ERROR, and set it to any value. If any problems loading CGM files are still present, disable the override by deleting the TCVIS_IGNORE_CGM_RASTER_ERROR environment variable and restarting Teamcenter lifecycle visualization.

VCD and SCD files do not load correctly when you use the example immersive configuration file

Problem

Example files provided with Teamcenter lifecycle visualization include a file called ImmersiveConfig.xml, which you can use to configure the viewer to work with TrackD, InterSense, or VRPN. When using ImmersiveConfig.xml, the Video Configuration Description (VCD) and Sensor Configuration Description (SCD) files do not load correctly when immersive mode is activated.
Workaround: You must change the following settings in the `ImmersiveConfig.xml` file to point to the VCD and SCD files for your current system. Use absolute paths or relative paths that are relative to `ImmersiveConfig.xml`. For example:

```
<VCD_File name=" C:/Program Files/Siemens/TeamcenterXXX/Visualization/Examples/Concept/Configuration_Files/VCD/Monitor.vcd"/>
```

```
<SCD_File name=" C:/Program Files/Siemens/TeamcenterXXX/Visualization/Examples/Concept/Configuration_Files/SCD/InterSense_HeadAndWand.scd"/>
```

**No connection to hardware devices when immersive mode is activated**

**Problem** When the immersive mode is activated, Teamcenter lifecycle visualization does not connect to hardware devices.

**Workaround** In the `ImmersiveConfig.xml` file, set `<Auto_Activate name=""/>` to a value of the corresponding hardware device server name.

For example, to connect to a VRPN server, set the value as:

```
<Auto_Activate name="VRPN"/>
```

Available options for the hardware device server names are:

- TrackD
- InterSense
- VRPN

If you are using ZSpace, Oculus Rift, or HTC Vive, use the corresponding configuration file.

**Animations created with Capture Walk not saved correctly**

**Problem** Animations created with the Capture Walk option under Tracking Camera action are not saved correctly in Tc Vis 11.1.1. Such animation data will not load correctly in later TcVis versions.

**Workaround** Any Animation data created with the tracking camera action in TcVis 11.1.1 must be recreated in later versions.

**Fast Mode and Manual Update options in 3D Section are disabled**

**Problem** The Fast Mode option in the cross section preferences and the Manual Update menu item and toolbar option are disabled.

**Workaround** None.
CAE data does not display properly on Linux and OS X

<table>
<thead>
<tr>
<th>Problem</th>
<th>The CAE data does not display properly on Linux and OS X.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workaround</td>
<td>None. The CAE visualization functionality introduced in Teamcenter Visualization 11.1 is not fully supported by the graphics card drivers currently available for Linux and OS X.</td>
</tr>
</tbody>
</table>

Missing CAE units in CAE Viewing

<table>
<thead>
<tr>
<th>Problem</th>
<th>All the CAE units except Millimeters are displayed as Unknown in CAE Viewing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workaround</td>
<td>None. The CAE units in CAE Viewing are not supported in Teamcenter Visualization 11.1.</td>
</tr>
</tbody>
</table>

Multiple clipped cross sections with capping do not display correctly

<table>
<thead>
<tr>
<th>Problem</th>
<th>If you create multiple clipped cross sections with capping enabled, the resulting view may render incorrectly. It may look as if you can see through the capped sections and see the backs of the other capped sections.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workaround</td>
<td>None</td>
</tr>
</tbody>
</table>

Missing UI text on Linux

<table>
<thead>
<tr>
<th>Problem</th>
<th>On Linux systems running in one of the UTF-8 locales (en_US.UTF-8), text may be missing from the Teamcenter lifecycle visualization user interface. For example, text may be missing from the assembly tree or the File Open dialog box. On systems with this issue, when you start the application, it may display the following error message:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Font Creation Failed</td>
</tr>
<tr>
<td>Also, the X11 log file (/var/log/Xorg.0.log) may contain error messages such as the following:</td>
<td></td>
</tr>
<tr>
<td>FreeType: couldn't find encoding 'iso8859-15' for '/..../generic.ttf'.</td>
<td></td>
</tr>
<tr>
<td>This is a result of some Linux distributions failing to generate the encodings.dir file during installation. X11 requires the encodings.dir file to load fonts in UTF-8 locales.</td>
<td></td>
</tr>
</tbody>
</table>
Workaround

1. Ensure that all X11 Unicode font packages are installed.

2. Navigate to the X11 fonts/encodings/ directory. On Red Hat Enterprise Linux 6, this directory is located at /usr/share/X11/fonts/encodings, but other distributions may put the encodings folder in a different location.

3. If the encodings.dir file does not exist in this location, generate the file using the mkfontdir command. On Red Hat 6, type the following at the command prompt:

   cd /usr/share/X11/fonts/encodings
   as root mkfontdir -e /usr/share/X11/fonts/encodings \
       -e /usr/share/X11/fonts/encodings/large

   **Note**

   You must run the mkfontdir command from the directory containing the encodings, and it should have a separate -e flag for each subdirectory that also contains encodings, such as the encodings/large/ subdirectory on RedHat 6.

4. If the encodings.dir file exists and the problem persists, check to make sure that it includes encodings for each of the classes in the XLC_LOCALE file for the locale (in /usr/share/X11/locale/en_US.UTF-8/ on Red Hat 6, for example), or regenerate the encodings.dir file using the above directions.

Visualization files are not associated with the viewer on OS X

**Problem**

When you install Teamcenter lifecycle visualization on a Mac, the installer does not automatically associate supported file types with the viewer. You must manually associate supported file types with the viewer to do the following:

- Double-click a supported file type to open it in the viewer.
- Send visualization files from the Teamcenter Thin Client or Community directly into the viewer.

**Workaround**

In the Visualization application installation directory, there is a simple native Mac OS X application called ViewerLauncher.app which you can associate with Lifecycle Visualization file types.

When you double-click a visualization file type that has been associated with ViewerLauncher.app, the application launches one of the following scripts:

- bin/vvbaselaunch
- bin/vvstdlaunch
- bin/vvprolaunch
By default, the script launched is vvprolaunch, which corresponds to the Professional license level. You can modify the following file to specify a different license level:

**ViewerLauncher.app/Contents/Resources/English.lproj/Settings.txt**

**Note**
If you are using Safari to send visualization files from the Teamcenter Thin Client or Community directly into the viewer, you must also configure the browser to treat .vvi files as safe files.

**VVI files are not sent directly into the viewer on OS X**

**Problem**
When using the Teamcenter Thin Client or Community in Safari, .vvi files are not sent directly into the viewer. Instead, the .vvi is saved to your local file system, and you must manually open it in the viewer.

**Workaround**
You must configure Safari to treat .vvi files as safe files for visualization data to open directly in the viewer. This behavior is controlled with a plist file named “com.apple.DownloadAssessment.plist”. This file is packaged with the ViewerLauncher.app. Copy it to this location:

`${Home}/Library/Preferences`

The key named “LSRiskCategorySafe” defines file types that are treated as safe and automatically opened in the viewer. The subkey “LSRiskCategoryContentTypes” defines an array of safe file extensions called “LSRiskCategoryExtensions”, which must contain a string named “VVI”. Note that the sample .plist file included with the installation is already configured to treat .vvi files as safe.

**Teamcenter Visualization is not installed to the Applications folder on OS X**

**Problem**
On Mac OS X, the Teamcenter lifecycle visualization application and related files are not installed to the Applications folder.

**Workaround**
If you want ViewerLauncher.app to be in the Applications folder, you must do the following:

1. From the command prompt, move all of the visualization files and folders at the same level as ViewerLauncher.app into the ViewerLauncher.app application bundle (Mac .app files include a hidden folder structure, with the top-level directory having a name that ends with the .app extension).

2. Move ViewerLauncher.app to the Applications folder.
Product views display parts in incorrect positions

Problem Parts may appear in incorrect positions when product views authored in the Lifecycle Viewer or the stand-alone viewer are restored in certain Teamcenter embedded viewers. This problem occurs when the motion system records part transformations on subassembly nodes, and the transformations are subsequently captured by the product view. These assembly-level transformations generated by the motion system are not applied correctly when the product view is restored in Structure Manager, Multi-Structure Manager, and Manufacturing Process Planner.

Workaround You can avoid this limitation by keeping 3D part transformations at the part level when working with motion in the Lifecycle Viewer or the stand-alone viewer. Rather than transforming an entire assembly or subassembly, expand the structure and select all of the individual parts and move them instead.

The help does not display properly in Internet Explorer 9

Problem When the Internet Explorer 9 Compatibility View setting is turned off, the help does not display properly.

Workaround To view the help in Internet Explorer 9, you must turn on Compatibility View. In IE 9, do the following:

2. In the Compatibility View Settings dialog box, select the Display all websites in Compatibility View check box.

An ActiveX warning is displayed each time the help is started

Problem When you launch the help, an ActiveX warning is displayed.

Workaround To get rid of the ActiveX warning, do the following:

1. Choose Tools→Internet Options→Advanced.
2. In the Settings area, scroll down to the Security section, and select the Allow active content to run in files on My Computer check box.
3. Click OK.
4. Close and reopen the browser.
Rendering artifacts during moving frame navigation

**Problem**
Lifecycle Visualization includes new technology to greatly increase the interactivity of moving frame navigation for medium and large assemblies on multi-processor workstations. This feature is automatically disabled on single-CPU machines.

When you navigate rapidly about the 3D model, objects near the edge of the Viewing window may be delayed for a few frames before appearing. This is a normal side-effect of the performance enhancement. The severity of the effect is proportional to the size of the assembly being viewed, the number of polygons being rendered, and the speed of the graphics card.

**Workaround**
To turn this feature off, you must set the environment variable `TCVIS_DISABLE_ASYNCSTRATEGY` to True. However, you should disable this feature only if your machine freezes or crashes.

Issue with nVidia G-Sync cards

**Problem**
If you have an nVidia G-Sync option card, unexpected errors may occur when using it in a PC cluster environment. Graphics adapters that support the nVidia G-Sync option card include the nVidia Quadro FX graphics solutions.

**Workaround**
The problem has been fixed in nVidia driver version 197.28 and above. To resolve the issue, update your driver.

If you are using an older driver, you can set up the following system environment variable to disable the G-Sync effect in Lifecycle Visualization:

```
TCVIS_CLUSTER_NOGSYNC=True
```

Visibility filter and Use Off-Screen Rendering option

**Problem**
When you turn off Use Off-Screen Rendering, the 3D graphics window must be completely clear of other windows. If any windows are covering the 3D graphics window in any way, the visibility check does not work.

**Workaround**
It is recommended that you do not turn off Off-Screen Rendering.

Installing the Windows cluster service

**Problem**
A cluster is a Windows-based system that contains multiple workstations. Before you can use clusters, you must install an additional Windows service program (TeamcenterVisClusterLaunch.exe) on the client nodes.

**Workaround**
Install the Windows cluster service. For information on installing the service, see Installing and uninstalling the Windows cluster service in the stand-alone Lifecycle Visualization Installation Guide.
Functionality not supported in PC clusters

Problem Some functionality where new geometry or other content is generated dynamically during the course of the session will not work with PC clusters, including, but not limited to the following:

- Part edit
- Environment map image captures for advanced materials
- Jack
- Variation Analysis
- Visualization Illustration
- 3D compare
- Surface analysis
- Layer filters
- Animation file loading

Workaround None

Attempting to interoperate an assembly to a new NX manager fails

Problem Interoperating an assembly to a new NX manager from Lifecycle Visualization fails if the assembly was originally sent to Lifecycle Visualization from Teamcenter.

Workaround Start NX from Teamcenter before interoperating an assembly from Lifecycle Visualization. From the File→Interoperate menu in Lifecycle Visualization, choose the running NX manager instead of a new NX manager.

Assembly names are different when sent from NX and Teamcenter

Problem If an assembly is sent to Lifecycle Visualization directly from Teamcenter, the name in the assembly tree view has the Item ID, ItemRev, and ItemName. The Item ID, ItemRev, and ItemName are not present if the assembly is sent from NX.

Workaround A solution where the Item ID, ItemRev, and ItemName are sent to Lifecycle Visualization as user data in the PLM XML is in NX 5.0.2 and later releases. This solution allows a Lifecycle Visualization user to add these as columns in the Assembly Tree. A longer term solution also is under investigation.
Session files lose association to animation files

Problem On Linux, you will encounter issues when you have a session file that references an animation primary document. When a 3D view from the session file is associated with the animation, that relationship should be preserved and re-established when you open the session. However, on Linux the relationship between the 3D view and the animation does not get re-established. Therefore, if you run the animation, it attempts to create a new 3D view instead of using the one that is present as part of the session.

Workaround Perform the following steps:

1. Load the session (this loads the 3D view and the animation document).
2. Select the 3D view to be the animation target.
3. Select a part in the Viewing window.
4. Choose Animation→Associate 3D View with Animation.

Cannot save PLM XML motion file formats to Teamcenter

Problem When you try to save motion data to Teamcenter using the PLM XML Motion Frame or PLM XML Motion Keyframe file formats, an error message is displayed.

Workaround You must use the VFM file format when saving motion data to Teamcenter. The PLM XML motion file formats are not supported.

Support for localized user interface in Visualization Illustration

Problem The language shown on the user interface may be inconsistent when using Visualization Illustration.

Workaround To provide a consistent user interface with respect to the user interface language presented by the viewer and the user interface language presented by the Visio Drawing Control, you must install one of the following:

- An English Visio 2010, 2013, or 2016 product install and a MUI pack supporting the language of choice

- A localized Visio2010, 2013, or 2016 product install for the language of choice

Only when the Microsoft Office 2010 or Visio 2013 Language Settings tool has the user interface language set to the same language as specified for the default system locale will the user interface language be consistent throughout the entire Visualization Illustration application.
In non-English versions of Visualization Illustration, opening an SVG file containing Assets displays a blank screen.

Problem: Opening an SVG file containing Assets displays a blank screen when Windows is configured to use a comma as the decimal symbol.

Workaround: Configure Windows to use a period as the decimal symbol.

1. Open Windows Control Panel.
2. Choose Region and Language.
3. In the Region and Language dialog box, on the Formats tab, click Additional setting.
4. In the Customize Format dialog box, on the Numbers tab, change Decimal symbol from "," to ".".

Visualization Illustration asset capturing may stop working after uninstalling Lifecycle Visualization

Problem: After uninstalling Lifecycle Visualization when a previous version of Lifecycle Visualization is still installed, you may need to repair the previous installation to restore the proper functioning of the previous version of Asset Capture. This problem results in the following error message: Failed to create the session data container.

Workaround: 1. From the Common Files installation folder (for example, C:\Program Files\Common Files\Siemens Shared\TcVis\9.1), remove the module VP3DGeomAssetData.dll.
2. Run the repair option of the installation of the earlier version of Lifecycle Visualization.

Visualization Illustration enablement

Problem: Visualization Illustration users may notice that even though they have installed Visualization Illustration, they are not seeing certain functionality exposed. In particular, the following:

- The Asset Clipboard does not appear when a 3D view is opened.
- You cannot capture a 3D geometry asset.

Workaround: The first and most obvious reason for this may be a lack of a new Visualization Illustration license.

The second reason for this may be the absence of a Visio 2010, 2013, or 2016 installation. If either of these is not available, Visualization Illustration and all related functionality will be disabled.
Microsoft installer launches on start of Visio

Problem  The Lifecycle Visualization installer does not associate the Visio .vsd file type with Visio. As a result, double-clicking a .vsd file causes the Visio application to launch and load the document. However, because Visualization Illustration Technical Illustrations are built using Visio as a drawing engine, Technical Illustrations are Visio documents with a .vsd extension. As a result, there are some users that elect to associate the Viewer with the .vsd file type. By doing so, double-clicking a .vsd file causes the Viewer to launch and load the document. Regardless of which application is associated with the .vsd file type, .vsd files can always be opened in the Viewer through File → Open.

If Microsoft detects during the startup of Visio that the .vsd file is not associated with the Visio application, the Microsoft Installer runs as a means to automatically repair what Microsoft views as a broken association. A description of this behavior can be found at http://support.microsoft.com/?id=290997. At the bottom of this article is a link that describes how to disable this behavior. However, this approach completely disables the Microsoft Installer.

Workaround  A workaround for this problem is to not associate the .vsd file type with the Viewer. Rather than double-clicking the .vsd file type to launch the application, right-click the .vsd file and use the Microsoft Explorer Open With shortcut menu to open the file.

Variation Analysis issues

Problem  The following issues apply to Variation Analysis.

- When extracting NX PMI data from a JT file, slot and tab patterns are not supported.

- When extracting NX PMI data from a JT file, the following tolerances do not flow down to Variation Analysis.
  - PMI shown in multiple NX views are duplicated in JT PMI and subsequently in the Variation Analysis.
  - Unilateral and unequal bilateral profile tolerances indicated by the modifier are not recognized.

- Reference dimension and angular plus-minus tolerances are not recognized.

- The flowdown of linear plus-minus tolerances (directed dimensions in NX PMI) require NX 10 or later.

- Rename/Remap does not work when the object being moved is the assembly node that is being duplicated.

- FCFs (Feature Control Frames) show a non-existing datum reference when a feature is linked to the tolerance library.
| Workaround | None |
Chapter 10: Supported file formats

Teamcenter lifecycle visualization supports the following file formats:

- 2D file formats
- 3D file formats
- ECAD file formats
- 2D/3D file formats
- Lifecycle Visualization authored file formats
- Motion file formats supported for conversion to VFM
- Visualization Illustration supported file formats
- Lifecycle Visualization file formats
- Supported versions of the JT file format
- Supported versions of other Siemens PLM Software file formats

Note

- Some file types may need an optional translator. Consult your system administrator for assistance.
- To view, convert, and print Office documents, you must have Microsoft Office installed.
- To avoid seeing construction geometry in Lifecycle Visualization, clean up your construction geometry in NX before opening the file in the viewer.
- Non-geometry data, such as PMI, is not supported.
- Wireframe data is not supported.
- 2D .prt files must contain embedded CGM data.

2D file formats

You can open the following 2D file formats:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raster and Document</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Extension</td>
<td>Description</td>
<td>Type</td>
<td>Prerequisites</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------------</td>
<td>------</td>
<td>---------------</td>
</tr>
<tr>
<td>BMP</td>
<td>.bmp</td>
<td>Microsoft Windows or OS/2 bitmap file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>C4</td>
<td>.C4</td>
<td>JEDMICS C4 tiled raster format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>CG4</td>
<td>.CG4</td>
<td>CALS Group IV format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>DOC</td>
<td>.doc</td>
<td>Microsoft Word</td>
<td>Document</td>
<td>Install MS Word</td>
</tr>
<tr>
<td>DOC</td>
<td>.docx</td>
<td>Microsoft Word</td>
<td>Document</td>
<td>Install MS Word</td>
</tr>
<tr>
<td>DFT (Windows only)</td>
<td>.dft</td>
<td>Solid Edge draft files</td>
<td>Raster</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note**

For details on supported versions, see Supported versions of other Siemens PLM Software file formats.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMF (Windows only)</td>
<td>.emf</td>
<td>Microsoft Enhanced Metafile</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>GIF</td>
<td>.gif</td>
<td>CompuServe color raster format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>HDR</td>
<td>.hdr</td>
<td>High Dynamic Range images</td>
<td>Raster</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note**

High Dynamic Range (HDR) images are supported for 3D light maps only. Light maps can use OpenEXR or Radiance RGBE Encoding HDR images.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>.dept, .jpeg, .jiff, .jpe, .jpg</td>
<td>JPEG file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Extension</td>
<td>Description</td>
<td>Type</td>
<td>Prerequisites</td>
</tr>
<tr>
<td>--------------</td>
<td>------------</td>
<td>------------------------------------------</td>
<td>--------</td>
<td>----------------</td>
</tr>
<tr>
<td>JPEG 2000</td>
<td>.j2k, .jp2, .jpc</td>
<td>JPEG 2000 file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Using Teamcenter Visualization 2005 and later, you can display and save JPEG 2000 files.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLR</td>
<td>.mlr, .mil, .milr, .CAL</td>
<td>MIL-R-28002 Type 1 Raster</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>MPP</td>
<td>.mpp</td>
<td>Microsoft Project</td>
<td>Document</td>
<td>Install MS Project</td>
</tr>
<tr>
<td>MPC</td>
<td>.mpc</td>
<td>Multi-page CALS file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>PBM</td>
<td>.pbm</td>
<td>Portable BitMap image file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The application only supports viewing this file type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PCX</td>
<td>.pcx</td>
<td>Windows Paintbrush image file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>PGM</td>
<td>.pgm</td>
<td>Portable GrayMap image file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The application only supports viewing this file type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td>.png</td>
<td>PNG file format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>PNM</td>
<td>.pnm</td>
<td>Portable AnyMap image file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The application only supports viewing this file type.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Chapter 10: Supported file formats

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPM</td>
<td>.ppm</td>
<td>Portable PixMap image file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The application only supports viewing this file type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PPT</td>
<td>.ppt</td>
<td>Windows PowerPoint</td>
<td>Document</td>
<td>Install MS PowerPoint</td>
</tr>
<tr>
<td>PPT</td>
<td>.pptx</td>
<td>Windows PowerPoint</td>
<td>Document</td>
<td>Install MS PowerPoint</td>
</tr>
<tr>
<td>PS</td>
<td>.ps,.eps</td>
<td>PostScript (Level 1, Level 2, EPS)</td>
<td>Raster</td>
<td>Install Ghostscript</td>
</tr>
<tr>
<td>RAS</td>
<td>.ras,.sun</td>
<td>Bi-level Sun raster</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>RGB</td>
<td>.rgb,.rgba,.sgi,.bw</td>
<td>SGI RGB file</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>RVF</td>
<td>.rvf</td>
<td>Raster Viewing Format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>TG4</td>
<td>.tg4</td>
<td>CCITT Group 4 Type II tiled image format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>TGA</td>
<td>.tga</td>
<td>Truevision Targa</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>TIFF</td>
<td>.tif,.tiff</td>
<td>Tagged Image File Format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>TLC</td>
<td>.tlc</td>
<td>TLC file format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>TRIFF</td>
<td>.fsx,.ovx,.fs,.ov</td>
<td>Monochrome, single and multi-page tiled raster file format</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>WBMP</td>
<td>.wbmp</td>
<td>Wireless Bitmap</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>WMF (Windows only)</td>
<td>.wmf</td>
<td>Windows Metafile</td>
<td>Raster</td>
<td>None</td>
</tr>
<tr>
<td>XLS</td>
<td>.xls,.cvs</td>
<td>Microsoft Excel</td>
<td>Document</td>
<td>Install MS Excel</td>
</tr>
<tr>
<td>XLS</td>
<td>.xlsx,.cvs</td>
<td>Microsoft Excel</td>
<td>Document</td>
<td>Install MS Excel</td>
</tr>
</tbody>
</table>

### Vector

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>907</td>
<td>.906,.907,.CAL</td>
<td>Calcomp 906, 907</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Extension</td>
<td>Description</td>
<td>Type</td>
<td>Prerequisites</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------------</td>
<td>------</td>
<td>---------------</td>
</tr>
<tr>
<td>CGM</td>
<td>.cgm</td>
<td>Binary Computer Graphics Metafile MIL-D-28003 ANSI X3.122</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Teamcenter Visualization 2005 and later supports CGM Version 4, while maintaining support for CGM Versions 1 through 3. Teamcenter Visualization 2005 also supports WebCGM files.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DGN (Windows only)</td>
<td>.dgn</td>
<td>Microstation DGN file format (available on Windows)</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td>DWF</td>
<td>.dwf</td>
<td>Autodesk Drawing Web Format files</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> The application supports DWF version 6 formatted files, including the new .w2d file extension. Embedded raster data is supported only on Windows.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 10: Supported file formats

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>DWG</td>
<td>.dwg</td>
<td>AutoCAD Internal file format</td>
<td>Vector</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note**
The following types of embedded raster data are supported: BMP, JPG, GIF, MLR, TIFF, and PNG.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>GERBER</td>
<td>.gbr, .gbx, .gvl</td>
<td>Gerber RS274D and RS274X formats</td>
<td>Vector</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note**
Use .gvl files to open a list of Gerber files as one document with layers for each file in the list.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPGL</td>
<td>.hgl, .hpg, .hpgl, .hp2, .plt</td>
<td>HP Graphics Language (HPGL and HPGL/2)</td>
<td>Vector</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note**
The application recognizes additional files as HPGL if you set the EAI_HPGL_EXTENSIONS environment variable. The setting should be a comma separated list of file extensions.

**Example**
"hpgl2,hpgl3"
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDW (Windows only)</td>
<td>.idw</td>
<td>Autodesk Inventor drawing file format</td>
<td>Vector</td>
<td>To work with the Autodesk Inventor files, you must have Autodesk Inventor, Autodesk Inventor View, or Design Tracking. Autodesk Inventor View and Design Tracking are freely distributed and available from Autodesk. Autodesk Inventor .idw files prior to version 5.3 are not supported.</td>
</tr>
<tr>
<td>IGES</td>
<td>.igs, .iges</td>
<td>Initial Graphics Exchange Input File Specification, MIL-D-28000</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td>MDL</td>
<td>.mdl</td>
<td>Model file</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td>W2D</td>
<td>.w2d</td>
<td>Autodesk toolkit</td>
<td>Vector</td>
<td>None</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AI</td>
<td>.ai</td>
<td>Adobe Illustrator</td>
<td>Vector or Raster</td>
<td>For Linux, and Mac, install Ghostscript</td>
</tr>
<tr>
<td>MDS</td>
<td>.mds</td>
<td>MetaData Stamp</td>
<td>Vector or Raster</td>
<td>None</td>
</tr>
<tr>
<td>PDF</td>
<td>.pdf</td>
<td>Portable Document Format</td>
<td>Raster</td>
<td>For Linux, and Mac, install Ghostscript</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>On Windows, you can directly create and work with PDF documents.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TXT</td>
<td>.txt</td>
<td>ASCII text file format</td>
<td>Document</td>
<td>None</td>
</tr>
<tr>
<td>WebCGM</td>
<td>.cgm</td>
<td>CGM file management through Web browsers, hyperlinks, and other supported WebCGM file features.</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>
### Chapter 10: Supported file formats

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
<th>Type</th>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZIP</td>
<td>.zip</td>
<td>ZIP files containing one or more files of a supported 2D format</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>&lt;br&gt;The 2D files contained within the ZIP file are displayed in a single multipage 2D image window. You can navigate through the pages (files) using any of the available 2D multipage navigation options.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7-Zip</td>
<td>.7z</td>
<td>7-Zip files containing one or more files of a supported 2D format</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>&lt;br&gt;The 2D files contained within the 7-Zip file are displayed in a single multipage 2D image window. You can navigate through the pages (files) using any of the available 2D multipage navigation options.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 3D file formats

You can open the following 3D file formats:
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASM (Windows only)</td>
<td>.asm</td>
<td>Assembly file for Solid Edge that can reference .par, .psm, .pwd, and other .asm files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For details on supported versions, see Supported versions of other Siemens PLM Software file formats.</td>
</tr>
<tr>
<td>BLK</td>
<td>.blk</td>
<td>NASTRAN bulk format</td>
</tr>
<tr>
<td>IGES 5.3</td>
<td>.igs, .iges</td>
<td>Initial Graphics Exchange Input File Specification, MIL-D-28000</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To work with IGES files, the IGES optional translator must be properly installed and licensed.</td>
</tr>
<tr>
<td>JT</td>
<td>.jt</td>
<td>DirectModel file format</td>
</tr>
<tr>
<td>PAR (Windows only)</td>
<td>.par</td>
<td>Solid Edge single part file</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For details on supported versions, see Supported versions of other Siemens PLM Software file formats.</td>
</tr>
<tr>
<td>PLM XML</td>
<td>.plmxml</td>
<td>XML format that supports product view and product structure data</td>
</tr>
<tr>
<td>PSM (Windows only)</td>
<td>.psm</td>
<td>Solid Edge sheet metal file</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For details on supported versions, see Supported versions of other Siemens PLM Software file formats.</td>
</tr>
<tr>
<td>PWD (Windows only)</td>
<td>.pwd</td>
<td>Solid Edge weldment file</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For details on supported versions, see Supported versions of other Siemens PLM Software file formats.</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Extension</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>RES</td>
<td>.res</td>
<td>ADAMS results file format</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Lifecycle Visualization supports ADAMS RES 2010 and 2013 files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The ADAMS conversion feature, which converts RES files to the VFM motion file format, requires the Professional or Mockup product configuration, as well as an additional license. It is supported on Windows only.</td>
</tr>
<tr>
<td>STEP AP203, 214</td>
<td>.stp</td>
<td>Standard for Exchange of Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To work with STEP files, the STEP optional translator must be properly installed and licensed.</td>
</tr>
<tr>
<td>VRML</td>
<td>.wrl, .vrml</td>
<td>Virtual Reality Markup Language</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VRML support is for geometry and appearance attributes only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You can export 3D models in only the VRML 1.0 format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Both VRML 1.0 and 2.0 files can be imported.</td>
</tr>
<tr>
<td>XMO</td>
<td>.xmo</td>
<td>XML-based motion file format</td>
</tr>
<tr>
<td>XT</td>
<td>.x_t, .x_b, .xmt_txt, .xmt_bin</td>
<td>Parasolid XT File</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For details on supported versions, see Supported versions of other Siemens PLM Software file formats.</td>
</tr>
</tbody>
</table>

**Note**
The CADDS format is no longer supported. You can use the CADDS to JT translator to translate single CADDS files or to perform automated batch translations of multiple CADDS files.
**ECAD file formats**

You can open the following file formats in ECAD:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCZ</td>
<td>.bcz</td>
<td>Teamcenter Briefcase</td>
</tr>
<tr>
<td>XFATF</td>
<td>.xfatf</td>
<td>PCB file</td>
</tr>
<tr>
<td>XSCH</td>
<td>.xsch</td>
<td>Schematic File</td>
</tr>
<tr>
<td>XRUL</td>
<td>.xru</td>
<td>Contains the ECAD DFx rules.</td>
</tr>
<tr>
<td>XRES</td>
<td>.xres</td>
<td>Contains the ECAD DFx results.</td>
</tr>
<tr>
<td>CGM</td>
<td>.cgm</td>
<td>ECAD Markup layer.</td>
</tr>
</tbody>
</table>

**2D/3D file formats**

You can open the following 2D/3D file formats:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DXF</td>
<td>.dxf</td>
<td>AutoCAD drawing interchange format</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To work with 3D DXF files, the DXF optional translator must be properly installed and licensed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The following types of embedded raster data are supported: BMP, JPG, GIF, MLR, TIFF, and PNG.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Solids are not supported.</td>
</tr>
<tr>
<td>DWG</td>
<td>.dwg</td>
<td>AutoCAD Internal file format</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The following types of embedded raster data are supported: BMP, JPG, GIF, MLR, TIFF, and PNG.</td>
</tr>
<tr>
<td>IGES</td>
<td>.igs, .iges</td>
<td>Initial Graphics Exchange Input File Specification, MIL-D-28000</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>To work with IGES files, the IGES optional translator must be properly installed and licensed.</td>
</tr>
</tbody>
</table>
### Lifecycle Visualization authored file formats

You can save data as the following file formats:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>907</td>
<td>.907</td>
<td>Calcomp 907</td>
</tr>
<tr>
<td>951</td>
<td>.951</td>
<td>Calcomp 951</td>
</tr>
<tr>
<td>AVI</td>
<td>.avi</td>
<td>Video (Windows)</td>
</tr>
<tr>
<td>BCZ</td>
<td>.bcz</td>
<td>Teamcenter Briefcase</td>
</tr>
<tr>
<td>BMP</td>
<td>.bmp</td>
<td>Microsoft Windows or OS/2 bitmap file</td>
</tr>
<tr>
<td>CGM</td>
<td>.cgm</td>
<td>2D Markup layer or ECAD</td>
</tr>
<tr>
<td>CSV</td>
<td>.csv</td>
<td>Clearance DB report</td>
</tr>
<tr>
<td>DBC</td>
<td>.dbc</td>
<td>Clearance DB Database Connection</td>
</tr>
<tr>
<td>ENV</td>
<td>.edv</td>
<td>Jack Environment (session)</td>
</tr>
<tr>
<td>FIG</td>
<td>.fig</td>
<td>Jack Figure (session)</td>
</tr>
<tr>
<td>GIF</td>
<td>.gif</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>HPGL</td>
<td>.hpg</td>
<td>HP Graphics Language (HPGL and HPGL/2)</td>
</tr>
<tr>
<td>J2K</td>
<td>.j2k, .jp2, .jpc</td>
<td>JPEG 2000</td>
</tr>
<tr>
<td>JPEG</td>
<td>.jpg</td>
<td>JPEG file</td>
</tr>
<tr>
<td>JT</td>
<td>.jt</td>
<td>DirectModel Format</td>
</tr>
<tr>
<td>MLR</td>
<td>.mlr, .mil, .milr</td>
<td>MIL-R-28002 Type 1 Raster</td>
</tr>
<tr>
<td>MPEG</td>
<td>.mpg</td>
<td>Video (Mac and Linux)</td>
</tr>
<tr>
<td>P-SURF</td>
<td>.pss</td>
<td>Jack P-Surface (Part)</td>
</tr>
</tbody>
</table>

**Note**

You must have a license to work with Visualization Illustration.

**Note**

You must have a license to work with Visualization Illustration.
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCX</td>
<td>.pcx</td>
<td>Windows Paintbrush image file</td>
</tr>
<tr>
<td>PDO</td>
<td>.pdo</td>
<td>Process documents</td>
</tr>
<tr>
<td>PFC</td>
<td>.pfc</td>
<td>Vehicle Integrated Process Flow Charts</td>
</tr>
<tr>
<td>PLMXML</td>
<td>.plmxm</td>
<td>Product Structure</td>
</tr>
<tr>
<td>PNG</td>
<td>.png</td>
<td>PNG file format</td>
</tr>
<tr>
<td>PS</td>
<td>.ps</td>
<td>PostScript (EPS)</td>
</tr>
<tr>
<td>PVL</td>
<td>.pvl</td>
<td>2D Image View List</td>
</tr>
<tr>
<td>ROBFACE</td>
<td>.asy</td>
<td>Robface format</td>
</tr>
<tr>
<td>RVF</td>
<td>.rvf</td>
<td>Raster Viewing Format</td>
</tr>
<tr>
<td>SCD</td>
<td>.scd</td>
<td>Sensor Configuration Definition</td>
</tr>
<tr>
<td>STEP AP203</td>
<td>.stp</td>
<td>Standard for Exchange of Product</td>
</tr>
<tr>
<td>SVG</td>
<td>.svg</td>
<td>Scalable Vector Graphics</td>
</tr>
<tr>
<td>TIFF</td>
<td>.tif</td>
<td>Tagged Image File Format</td>
</tr>
<tr>
<td>TXT</td>
<td>.txt</td>
<td>3D Measurement Report, 3D PMI Point Report, Clearance Results</td>
</tr>
<tr>
<td>V3G</td>
<td>.v3g</td>
<td>3D Geometry Asset</td>
</tr>
<tr>
<td>VAN</td>
<td>.van</td>
<td>Animation</td>
</tr>
<tr>
<td>VCD</td>
<td>.vcd</td>
<td>Video Configuration Definition</td>
</tr>
<tr>
<td>VF</td>
<td>.vf</td>
<td>Work sessions</td>
</tr>
<tr>
<td>VFM</td>
<td>.vfm</td>
<td>Motion</td>
</tr>
<tr>
<td>VFZ</td>
<td>.vfz</td>
<td>Work Session Package</td>
</tr>
</tbody>
</table>

**Note**
You must have a license to work with Visualization Illustration.

**Note**
To work with STEP files, the STEP optional translator must be properly installed and licensed.
### Supported file formats

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VML</td>
<td>.vml</td>
<td>Vector Markup Language</td>
</tr>
<tr>
<td>VPL</td>
<td>.vpl</td>
<td>3D markup layers</td>
</tr>
<tr>
<td>VRML</td>
<td>.wrl</td>
<td>Virtual Reality Markup Language</td>
</tr>
<tr>
<td>VSD</td>
<td>.vsd</td>
<td>Technical Illustration</td>
</tr>
<tr>
<td>VTP</td>
<td>.vtp</td>
<td>Technical Portfolio</td>
</tr>
<tr>
<td>VVS</td>
<td>.vvs</td>
<td>Viewer State Script</td>
</tr>
<tr>
<td>XML</td>
<td>.xml</td>
<td>Attribute Color, Search Trace Results file, SPC measurement data file, XML point import and export file, exported Flowchart file, ECAD markup metadata file</td>
</tr>
<tr>
<td>XRUL</td>
<td>.xrul</td>
<td>Contains the ECAD DFx rules.</td>
</tr>
<tr>
<td>XRES</td>
<td>.xres</td>
<td>Contains the ECAD DFx results.</td>
</tr>
<tr>
<td>ZN</td>
<td>.zn</td>
<td>Clearance Zone</td>
</tr>
</tbody>
</table>

#### Motion file formats supported for conversion to VFM

You can convert the following file types to the VFM motion file format:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMO</td>
<td>.xmo</td>
<td>Motion</td>
</tr>
<tr>
<td>RES</td>
<td>.res</td>
<td>ADAMS Results Files</td>
</tr>
</tbody>
</table>

#### Note

- Lifecycle Visualization supports ADAMS RES 2010 and 2013 files.
- The ADAMS conversion feature, which converts RES files to the VFM motion file format, requires the Professional or Mockup
### Abbreviation | Extension | Description
--- | --- | ---
| | | product configuration, as well as an additional license. It is supported on Windows only.

#### Visualization Illustration supported file formats

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP, DIB</td>
<td>.bmp, .dib</td>
<td>Windows Bitmap</td>
</tr>
<tr>
<td>EMZ</td>
<td>.emz</td>
<td>Compressed Enhanced Metafile</td>
</tr>
<tr>
<td>EMF (Windows only)</td>
<td>.emf</td>
<td>Enhanced Metafile</td>
</tr>
<tr>
<td>GIF</td>
<td>.gif</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>JPEG</td>
<td>.jpg</td>
<td>JPEG Interchange Format</td>
</tr>
<tr>
<td>PNG</td>
<td>.png</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>SVG, SVGZ</td>
<td>.svg, .svgz</td>
<td>Scalable Vector Graphics</td>
</tr>
<tr>
<td>TIF, TIFF</td>
<td>.tif, .tiff</td>
<td>Tag Image File Format</td>
</tr>
<tr>
<td>VML</td>
<td>.vml</td>
<td>Vector Markup Language</td>
</tr>
</tbody>
</table>

#### Lifecycle Visualization file formats

Lifecycle Visualization features utilize the following file formats:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV</td>
<td>.csv</td>
<td>ClearanceDB report</td>
</tr>
<tr>
<td>DBC</td>
<td>.dbc</td>
<td>ClearanceDB Database Connection file</td>
</tr>
<tr>
<td>ENV</td>
<td>.edv</td>
<td>Jack Environment (session)</td>
</tr>
<tr>
<td>FIG</td>
<td>.fig</td>
<td>Jack Figure (session)</td>
</tr>
<tr>
<td>eXT</td>
<td>.ext</td>
<td>ASCII XML format developed by Parasolid</td>
</tr>
</tbody>
</table>

**Note**
The application no longer saves data in the .eXT format. You can read .eXT files, but you can save product view data only in the .plmxml format.

| JT | .jt | DirectModel Format |
| PDO | .pdo | Process documents |
| PFC | .pfc | Vehicle Integrated Process Flow Charts |
| P-SURF | .pss | Jack P-Surface (Part) |
### Supported file formats

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLMXML</td>
<td>.plmxml</td>
<td>Product Structure</td>
</tr>
<tr>
<td>VAN</td>
<td>.van</td>
<td>Animation</td>
</tr>
<tr>
<td>VBK</td>
<td>.vbk</td>
<td>Illustration Book</td>
</tr>
<tr>
<td>VF</td>
<td>.vf</td>
<td>Work sessions</td>
</tr>
<tr>
<td>VFM</td>
<td>.vfm</td>
<td>Motion</td>
</tr>
<tr>
<td>VFP</td>
<td>.vfp</td>
<td>Autofile Locate preferences file.</td>
</tr>
<tr>
<td>VFZ</td>
<td>.vfz</td>
<td>Work Session Package</td>
</tr>
<tr>
<td>VPL</td>
<td>.vpl</td>
<td>3D markup layers</td>
</tr>
<tr>
<td>XML</td>
<td>.xml</td>
<td>Attribute Color, Search Trace Results file, SPC measurement data file, XML point import and export file, exported Flowchart file</td>
</tr>
<tr>
<td>XMO</td>
<td>.xmo</td>
<td>Motion</td>
</tr>
<tr>
<td>ZN</td>
<td>.zn</td>
<td>Clearance Zone</td>
</tr>
</tbody>
</table>

### Supported versions of the JT file format

You can open and, depending upon your licensing configuration, save the following versions of the JT file format:

<table>
<thead>
<tr>
<th>Teamcenter lifecycle visualization version</th>
<th>JT version</th>
<th>JT and XT B-Rep support</th>
<th>ULP support</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.x</td>
<td>8.1 and earlier</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>6.x</td>
<td>8.1 and earlier</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>2007 (PLM1)</td>
<td>8.3 and earlier</td>
<td>Yes</td>
<td>Preliminary</td>
</tr>
<tr>
<td>2007.1</td>
<td>9.1 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>2007.1.1</td>
<td>9.2 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>8.0</td>
<td>9.3 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>8.1</td>
<td>9.4 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>8.2</td>
<td>9.5 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>8.3</td>
<td>9.5 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>9.x</td>
<td>9.5 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>10</td>
<td>9.5 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>10.1</td>
<td>10.0 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11.1</td>
<td>10.0 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11.2</td>
<td>10.2 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11.3</td>
<td>10.2 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11.4</td>
<td>10.2 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11.5</td>
<td>10.2 and earlier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Supported versions of other Siemens PLM Software file formats

For information about the supported versions of other Siemens PLM Software file formats, see the Interoperability matrix on the Hardware and Software Certifications page on GTAC: https://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.
Chapter 11: Global Technical Access Center (GTAC)

To report any serious problems about Lifecycle Visualization, please contact the Global Technical Access Center.

Phone:

• USA and Canada: (800) 955-0000 or (714) 952-5444
• Outside the United States and Canada: Contact your local support office.

Website:

You can also log and view any existing resolutions for incident reports on the Web at http://www.siemens.com/gtac.
Siemens Industry Software

North America
Headquarters
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

Americas
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

Europe
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

Asia-Pacific
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.